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ABSTRACT

SAS® Web Report Studio is a rich Web-based reporting tool with a great deal of functionality built in over the course
of three major releases. You'll learn about techniques and creative solutions to answer common report challenges
that experienced users know and rely on, helping you to more effectively develop your reports.

OVERVIEW

The first two sections of this paper explain how to create reports that offer users more ways to retrieve targeted
results. The third section focuses on a powerful—but seldom used—feature that enables report authors to share
reports that are based on group breaks.

OPTIONAL PROMPTING: GIVING USERS THE CHOICE TO SUBSET OR NOT
Sometimes you want to offer users the choice of whether to subset a report or not. In order to do this, you must
provide a prompt value that represents all possible values (see Figure 1).

Please anzwer the prompts below and click the View Report button to continue,

* To see information for all emplovees, select 41l Emplovees from the drop-down list, To see

information for an individual emplovee, select that emplovee's number,

View Report Reset to Defaults

Figure 1. User Selects A11 Employees, Which Represents All Values

Because the user selected A11 Employees, information is displayed for all employees (see Figure 2).

Employee Number |Deptcode Diwvision ERp wyes Hire Date Status
e Gender
00000 150 INFORMATION SYSTEMS F 30JUL1991 N
000012 Qa0 GQUALITY ASSURAMNCE F 20MAY1933 N
000014 FIN FINANCE M 01MAY193 N
000018 TXR TEXAS REGIOMAL M 30JUL1991 W
000023 PUB PUBLICATIONS F 31JANTIST M
000024 TR TEXAS REGIOMNAL F 27NOV193 M
000026 HSD HOST SYSTEMS DEVELOPMENT M 15JAN1984 N
000027 TXR TEXAS REGIOMNAL i 05MAY1933 [
000030 FAC FACILITIES ] DEMARTS93 M
000034 FIM FINANCE ] 04JUMN1933 M
000035 CcCD SOFTWARE DEWELOPMENT M 14JUN1 983 M
000040 TR TEXAS REGIOMAL M 20MAY1933 H
000045 CON CONTRACTS I 1SFEB1991 N
000047 PUB CORPORATE COMMUNICATIONS L 225EP1992 N
000051 EDU EDUCATION M 10APR1992 N
000052 TXR TEXAS REGIOMAL M 29AUG1987 N
000053 FAC SOFTWARE DEVELOPMENT M 01JUN1954 N
000056 FAC FACILITES M 04JUnN1393 N
000059 SAM SALES & MARKETING ] 21DEC1989 N
000066 CON CONTRACTS ] I1MAY1991 M
000067 HRO HUMAN RESOURCES i 19JUN1333 M
000069 HSD HOST SYSTEMS DEVELCOPMENT ] 13SEP1931 M
[alalatairin] [alznY CEETVAME DE MEL /ST APRAERIT L ¥} A4 [ESA O 13}

Figure 2. Results Are Returned for A1l Employees



The following section explains how to create an optional prompted filter like the one that is shown in Figure 1.

Note: The following example is an overview of the complete steps that are outlined in SAS Sample 30924: "SAS
Web Report Studio: How to create optional prompts” (SAS Institute Inc. 2008).

CREATING THE FILTER
1. In SAS® Information Map Studio, select Insert » Data Item to open the Data Item Properties dialog
box. Name the new data item, and then click Edit to open the Expression Editor.
2. Select Character for the data item type. Then, in the Expression Text field, type a value within
single quotes. This is the value that users will select in SAS Web Report Studio (see Figure 3).

B« Tip: The expression does not have to match the name of the data item.

:E, Expression Editor

Marme: I.-'J-.II Employees

Description: I

Type: ICharan:ter LI

Expression Text:

‘&)l Employees'

-1+l anp|or|mMoT| =]==|<|==|=|==|=| 1|'_"|ty

Figure 3. The Expression for the New Data Item is a Simple Quoted String

3. After you create the data item, click Insert » Filter to open the New Filter dialog box. Enter a name
for the filter and then select the data item that you are filtering on, such as Employee Number. Set the
condition to Is equal to, and set the value to Prompt user for value(s).

4. Click Create Prompt to open the Prompt Properties dialog box. After naming the prompt, click the
Prompt Value Generation tab.

Ej Tip: Enter prompt text that will help users understand how to use the prompt.

5. For Prompt Type, select Prompt the user, using a custom list of values.’

6. Click Get Values to see the values that are available for the selected data item. Move the values that
you want to use from the Valid values list to the Current wvalues list. Click OK to return to the
Prompt Properties dialog box.

7. Back in the Prompt Properties dialog box, click Add Row (see Figure 4). For the Formatted and
Unformatted values, type the value that you entered in the Expression Text field in Step 2. Do not
use single quotes, but be sure to match the casing exactly.

Ej Tip: Move the new value to the top of the list and make it the default.

Ell Tip: You can make the prompt single or multi-select.

1 You also can use Prampt the user, using a custom list of values to enter a value. For instructions, see Sample 30924: "SAS
Web Report Studio: How to create optional prompts” (SAS Institute Inc. 2008).
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Walues list (values that the user will select from):

Default Formatted Unformatted

1 - All Employees All Ernployees

2 i 0a0o0 Qaoacq

3 i o001 2 Qo001 2

4 i o001 4 oo 4

] i 000015 Qo001 & Add Fovwy
B i 000023 Q00023 =

7 8 000024 000024 Delete Row
= i NNnn~a= nnn?e ;I :

Figure 4. The List of Values That Users Will Choose from Now Includes the Data Item Created in Step 2

8. Back in the Edit Filter dialog box, click Combinations, and then click Add to add the filter that you just
created to the Filter combinations box.

9. Inthe Data item list box, select the data item that you created in Steps 1 through 3.

10. Select Prompt user for value (s) and select the prompt that you created in Steps 5 through 8.

11. Click Add to add the new expression to the already existing expression.

12. Click the AND operator to change it to OR (see Figure 5).

Fitter combinations:

Eclit &
Al Employvess = (841 Employes Prampt [ Al Employes Promgt 1)

Delete

Figure 5. The Combination Filter That Will Be Used for the Optional Prompt

13. In SAS Web Report Studio, assign this filter to the applicable data item, such as Employee Number, used in
this example. Sample results are shown in Figures 1 and 2.

& Tip: When selecting the data items for the section query, do not include the data item that you
created. That data item is only a placeholder for creating the "all values" prompt.

REPORT LINKING: DESIGNING A DRILL PATH INTO DATA

You can simulate a cascading (also known as, drill through) prompt by using a little creativity with report linking.?
Figures 6 through 9 show the results of linking four reports that are based on the same information map. The user
drills down on Country, Region, and Division until the final report—subset by the previous selections—is
displayed.

2 The ability to create cascading prompts is planned for SAS® 9.2.
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SAS Web Report Studio - Country

Report = Edit Report

Please select a country

B B & i

Country
CAMNADA,
GERMARMY
Us.A,

Figure 6. The Initial Report in the Sequence (Country) Enables the User to Select a Country

The value for country (U.S.A.) is sent to the prompt for country in the Region report.

SAS Web Report Studio - Region

Report ~ Edit Report

1 Return to previous report: Country

U.5.A.

Please select a region

= A

|

m
=
[
=

;

Figure 7. The Second Report in the Sequence, Region, Enables the User to Select a Region

From the Region report, the value for the country group break (U.S.A.) and the value that the user selects for Region
(WEST) is sent to the prompts in the Division report.
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SAS Web Report Studio - Division

vt | Gt Repon

Sectionl Section?

1 Beturn to previous report: Region

U.5.A.

WEST

Please select a division

& i | i
Division
COMNSLUMER
EDUCATION

Figure 8. The Third Report in the Sequence, Division, Enables the User to Select a Division

From the Division report, the value for the country group break (U.S.A.), region group break (WEST), and the value
that the user selects for Division (EDUCATION) is sent to the prompts in the final report.

SAS Web Report Studio - Country_Region_Division

Report ~ Edit Report

4 Return to previous report: [ivision

U.5.A.
WEST
EDUCATION
& & &
tonth Jan Feb Mar Apr May Jun Jul Aug Sep Oct How Dec
Actual |Actual |Actual |Actual |Actual |Actual |Actual |[Actual |Actual |Actual |Actual |Actual
Sales Sales Sales Sales Sales Sales Sales Sales Sales Sales Sales Sales
Product
Product
Type
FURMITURE BED $433.00| FI3000| F50000| F465.00 (1 333.00 |F1,6587.00 | $1 677.00|[§1,357.00 | §791.00 [§1 55500 F1,051.00 (%1 179.00
SOFA $1,235.00 | F601.00 (§1 0450051 497.00( F996.00| F6135.00| F35000| H734.00| $17000| F427.00| F350000(F1,0035.00
CHAIR $252.00 |$1,323.00 | $777.00 |$1 76300 | $750.00| $434.00|$1,75600| $927.00 |§1,409.00 |§1,659.00 $562.00 |$1,057.00
OFFICE DESK $333.00 117900 $51300( $981.00| $905.00| $757.00|$1,368.00 |$1,001.00 |§1,539.00| $955.00|31,804.00( $672.00
TABLE $369.00 (§1,304.00| §795.00| F665.00| F630.00 F1,545.00| $250.00| $525.00(F1,570.00| §356.00(F1 517.00| F945.00

Figure 9. The Final Report, Subset by Previous Country, Region, and Division Selections, Is Displayed
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A BEHIND-THE-SCENES VIEW OF THE LINKING SEQUENCE
Each report contains the necessary prompts and group breaks so that values can be passed from one report to the
other. Figure 10 shows how the sequence works.

?’m‘% 1. Select a country from the
| GERMANY | Country Listing report.
Us.a,
v
Country Prompt 2. The selected Country value is
used to provide a value for the
¢ Country prompt.
Brodk by values of: Region Select a region from the
|CGun1H EAST Region Listing report.
WEST |

¥ Y
Country Prompt Region Prompt
| 3. The selected region value is
used to provide a value for the
region prompt.
Break by values of:

Country = The Country group break

value is passed to the Country
prompt.

Then by values of: Division
CONSLIMER

Region EDUCATION Select a division from the

Division Listing report.

A 2 A 2 A 2
Region Prompt Country Prompt Division Prompt
[ | |
¢ 4. The selected Division value
T ¥ == e and the values of the Country
Actual Actual Actual and Reglon group breé!ks n
Sales Sales Sales the second report provide
Product values for the Country,
Product . .
Type —_— Region, and Division prompts
NS UTURE | P2 704 00 | FE04.00 | $1 149600 in the final report.
SO FA BT 1 00 DD | $1 026 .00
CHAIR $1,357.00 | F213.00| $393.00
OFFICE DESK. $1,683.00 | $794.00| SH510.00
TABLE F1,374 .00 | $1,032.00 | $556.00

Figure 10. How Values Are Passed to Each Report
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LINKING TO REPORTS

To link the reports, complete the Report Linking dialog box for each table in each report. To access the dialog box,
select Report Linking from the Edit menu on the Table toolbar. In Figure 11, the first report in the sequence
is linked to the second report.

Iﬂ Tip: Add tool-tip text so that users know how to interact with the data.

2 Report Linking - Microsoft Internet Explorer provided b... M=l E3

M Include report links in the table

Link destination: & 4 existing report

C hweb page

Randy -
Ranking Regionlly

-[& RankingRegion007s

~[& Ranking Region007s

Ranking Regionl123

-[E] Ranking Regiondw - wysytkal

Ranking Regiondw - wyswikad backup —1
[ Ranking Regiondu - wysytkad

Ranking Regiondw - wysylka backup

Fegion -

Report: Region

Define prompts ...

Tool-tip text: Selecta cn:uuntnd

Figure 11. The Region Report is Selected as the Target for the Country Report

To associate the prompt in the Region report with the value selected in the Country report, click Define prompts
and select the prompt from the list box (see Figure 12). Any other required prompt values are supplied by the group
break values in the previous report (see Figure 10 for an illustration of how this works).

A Define Prompts - Microsoft Internet Ex... M=l E3

Optionally, assign a prompt to one or more data items.

Data ltems: Destination report prompts:

Country Country ;I

Figure 12. The Value of the Country Data Item in the Country Report is Associated with the Country
Prompt in the Region Report
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REPORT DISTRIBUTION: SELECTIVELY SHARING DATA

Report distribution allows you to e-mail or publish a report to one or more people. You can further tailor the report to
a user by using BY-group processing. By creating a report and distribution e-mail list with BY-group processing,
users will only see information in the report that is based on a particular subset of data.

Figures 13 through 16 show the grouped report, as well as the results of distributing this report via e-mail and a
publishing channel.

SAS Web Report Studio - Global Forum- Prdsales by Country

Report Edit Report

| A e @ PageSof5 o o |
..... BED
TABLE
i~ CHAIR
IES & & & | i
-SOFA Actual  |Predicted
> TRBLE Sales Sales
Product
— | Country | Region
Type

EAST  |§2594500| $25,035.00
WEST | ¢20,755.00) §21,854.00
EAST  |§25116.00| $25,932.00
WEST | $23,081.00 $23501.00
EAST | g22,256.00) $24 664.00
WEST | 424,045.00| §24,556.00

CANADA

OFFICE | GERMANY

U.S.A.

Figure 13. Report Grouped by Product

il Global Forum- Prdsales by Country (2).pdf - Adobe Reader
File Edit Wiew Docurment Tools ‘Window Help

HieeTn oeow - Bl Qe -
=]

o

BED
Actual Sales | Predicted Sales
Product Type |Country |Region
EAST §27,196.00 $22,799.00
CANADA : -
WEST $20,533.00 $21,416.00
EAST 23,537.00 21,634.00
FURNITURE |GERMANY e il
WEST $22,597.00 $22,162.00
U.SA EAST $23,137.00 $22,508.00
T WEST $25,037.00 $26,258.00

Figure 14. PDF Output Distributed via an E-mail Attachment
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SAS® Portal

RO A4y Collection 2

«

My Collection 4« Portal Page

b

Publication Channel Subscriptions keith

Click here 1o refresh collection.

5} Bookmark (@] E-mail

[ keith

Click here to refresh collection.

B keith

@ Sales Report
iarch Sales Report (pdf)
WwebDAVDemo/wrs/ s3952151352

Figure 15. PDF Output Distributed via Channel Subscription in SAS® Information Delivery Portal

Sales Report

5) Bookmark [&] E-mail

QS ales Beport
Global Forum-

Prdsales by Country

BED

Actual Sales | Predicted Sales

Product Type |Country |Region

EAST $27,196.00 $22,799.00
CANADA ; 2
WEST $20,533.00 $21,416.00
FURNITURE | GERMANY EAST $23,537.00 $21,634.00
WEST $22,597.00 $22,162.00
US.A EAST $23,137.00 $23,598.00
T WEST $25,037.00 $26,258.00

Figure 16. The Distributed Report Viewed via the Keith Publication Channel
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SETTING UP REPORT DISTRIBUTION WITH BY-GROUP PROCESSING
If a scheduling server is available and you are authorized to distribute reports, then the Distribute menu item

will be active in the SAS Web Report Studio Report menu. Here are the steps for completing the Distribution
Wizard.

1. With the report open in SAS Web Report Studio, select Report » Distribute from the Report
menu (see Figure 17).

Report ~ Edit Report

Hew
Hew Using Wizard ...
Hew From Template ...

Open ...
Quick Report ...

Save
Save As ...

Export
Schedule ...
Distribute ...

Figure 17. The Distribute Menu Item Launches the Distribution Wizard

2. In the Specify Recipient Rules dialog box, click New to create a new recipient list.
3. Name the list and then select the Create recipient list based on group break check box
(see Figure 18).

4. Inthe list box, select the group break that will be used to parse the distributed results. A report can have
more than one group break.

A New Recipient List - Microsoft Internet Explorer ... [H=lE3

Recipient list name:

Library name: maillib

¥ Create recipient list based on group break:

|F'rnduct LI

m Cancel ‘ Help |

Figure 18. The Product Group Break is Selected

10
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5. After you click OK, a new—but empty—recipient list (SAS table) is created (see Figure 19).

2 Specify Recipient Rules - Microsoft Internet Explorer provided by sAS M=l

Select recipient list:

BICLIEMTE
Mew ...
Remove

Product: Email and channels must be edited by using 545,

-

Product EMAIL CHAHHEL
BED
CHAIR
DESK
SOFA
TABLE

Divide report based on:
[~ Group break: Product LI

Assign group break categories to Product columin names:

Group break categories: Column names:
Product: Product ;I

m Cancel ‘ Help ‘

Figure 19. The Recipient Table is Created but the EMAIL and CHANNEL Columns are Initially Empty

6. Next, you must launch an interactive SAS session in order to assign a library (the default location is
\Lev1l\SASMain\Data\wrsdist) and add the e-mail addresses and channels to the recipient table
(see Figure 20).

@ Tip: Adding channels to the recipient list enables you to publish reports to channels that can be
displayed in the SAS Information Delivery Portal. You set up the channels in the SAS® Management
Console by using the Publishing Framework Plug-in.

E* VIEWTABLE: Maillib.Product

Froduct | EMAIL | CHANMEL s
1 BED keith. mpers@SASGlobalForum.com Keith
2 CHAIR ann.zmithi@yahoo.com
3 DESE Lynn. davis{inc, ir.com
4 SOFA madelyn.johnzonf@bellzouth. net
5 TABLE bruce. lee@iyahon. com

Figure 20. In an Interactive SAS session, You Enter E-mail Addresses and Channels into the Recipient Table

11
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7. Backin SAS Web Report Studio, select the Group break check box to associate the recipient list with
the Product group break (Figure 21).

2 Specify Recipient Rules - Microsoft Internet Explorer provided by 5AS M=l E3
Select recipient list:
BICLIEMTS
keith2 Mew ...
Remove
Product: Email and channels must be edited by using 545,
Product EMAIL CHAHHEL -
BED keith.myer s@SASG obalF orum.com Keith
CHAIR ann.smithi@yahoo.com
DESK Lynn davis@nc rr.com
SOF A madelyn johnzon@@belsouth . net
TABLE bruce lee@yahoo com
Divide report based on:
[¥ Group break: Froduct LI
Assign group break categories to Product column names:
r
Group break categories: Column names:
Product: Product ﬂ
0K | Cancel | Help |

Figure 21. The EMAIL and CHANNEL Columns in the Recipient Table Now Contain Values

12
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CONCLUSION

Optional prompts enable you to create more flexible reports that will serve more users. Creating linked reports that
can be used to drill down into data enables users to easily focus on a particular section of a report. Finally,
distributing reports based on BY groups is a powerful and easy way to selectively share content.
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